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https://www.bioinformatics.babraham.ac.uk/projects/seqgmonk/

SegqMonk Mapped Sequence Analysis Tool

« README

NSTALL Installation instructions for the program.

Release Notes Please read these before using the program.
=egMonk v1.48.1 for 64-bit Windows

segMonk v1.48.1 for 64-bit Linux

=egMonk v1.48.1 for 64-bit Mac OSX
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Mac OSX

* Download and run the DMG file
* Copy App to the Applications folder



Mac OSX

£ il Security & Privacy Q
General FileWault  Firewall B
U Reminders Allow the apps below to access data like Mail,
Messages, Safari, Home, Time Machine backups and
6 Photos certain administrative settings for all users on this Mac.

-! Camera - sshd
m Microphone @ SegMaonk
Accessibility

|_| Full Disk Access

H: 2: Automation
_|_ _
Analytics

@ Advertising

[ &
E Click the lock to prevent further changes. Advanced...




Linux

e Download tar file
e Run the launcher

student@ip-172-31-23-170:~% wget --quiet https://www.bioinformatics.babraham.ac.uk/projects/seqmonk/seqmonk v1.48.1 linux64.tar.gz
student@ip-172-31-23-170:~% tar -xzf segmonk v1.48.1 linux64.tar.gz

student@ip-172-31-23-170:~% cd SeqMonk/

student@ip-172-31-23-170:~/SeqMonk$ ./seqmonk

CLASSPATH is : /home/student/SegMonk:/home/student/SeqMonk/htsjdk.jar:/home/student/SeqMonk/Jama-1.0.2.jar:/home/student/SegMonk/comm
ons-math3-3.5.jar

Java interpreter is '/home/student/SeqMonk/jre/bin/java’

openjdk version "13.0.2" 2020-01-14

Open]DK Runtime Environment AdoptOpenl]DK (build 13.0.2+8)

Open]DK 64-Bit Server VM AdoptOpenl]DK (build 13.0.2+8, mixed mode, sharing)

Prefs file is at: /home/student/seqmonk prefs.txt

Set memory to 0 from prefs file

Memory ceiling is 10240

Raw physical memory is 7847

Using 5231 MB of RAM to launch segmonk

Correcting for VM actual requested allocation for 5231 is 5230

Command is: /home/student/SegMonk/jre/bin/java -Xss4m -Xmx5230m -Dawt.useSystemAAFontSettings=on -Dswing.aatext=true uk.ac.babraham.S
egMonk.SegMonkApplication



Installing R

* https://cran.r-project.org/

Download and Install R

Precompiled binary distributions of the base system and contributed packages,
Windows and Mac users most likely want one of these versions of B

¢ Download R for Linux (Debian, FedoraRedhat, Ubuntu)
* Download R for macOS
¢ Download R for Windows

E 1s part of many Linux distributions, you should check with your Linux package
management system 11 addition to the link above.

* Linux users need to install development versions of libssl, libcurl4,
libxml|2


https://cran.r-project.org/

First Launch

B Initial SeqMank Setup Ed

_%? Welcome to Segh g

Babraham SeqMonk Mapped Sequence Data Analyser

Institute

To get started with SegMonk we need to set up a couple of k vEfEan: 1 '43'2' dE?EI

1) A 'cache’ folder where SeqMonk can temporarily write da: www_bioinformatics.babraham.ac.u HJ’D[DPE‘CtSJ’

2) A folder to store downloaded genome annotation inform:  Babraham )

Institute @ Simon Andrews,Laura Biggins Babrahar % R Sessicn
We've assigned what we think are sensible values for these
feel free to change these if you want this data stored some HTSJDK BAM/SAM reader 8The Bread ' Citation() " on how to cite R or R packages in publications.
Once this is done you should be on your way
Type 'demo()' for some demos, 'help()' for omn-line help, or
6 10 GB of memary is available 'help.start()' for an HTHML browser interface to help.
Type 'g()' to guit R.
Cache Folder Location C:Wsers\andrewss/seqmonk_cache O You are running a current development version of SegMonk
Genomes Folder Location C:\Users\andrewss fseqmonk_genomes > % We need to specify a repository to use. If the user has one set
@ All of your installed genomes are up b date > # in their preferences then we'll use that. If not then we'll use
> ¥ the generic cloud E UEL.
>
Start Using SeqMonk @ Disk caching is available and enabled > repository = getOption ("CRAN", "attp://cloud.r-project.org")
>
O Found a valid R installation, but package dependencies wer| =
> ¥ We want to force windows and mac users to use binary distributions
e e s oo > #%# to do this we need to set the type value for install.packages. We
> ¥ need to look at the 05 to figure out what this should be
>
» if (Sys.info () ["svsname™] == "Windows"™) {
+ options (install.packages.check.source = "no")

Cancel



Creating a Project and Importing Data
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File > New Project

% Select Genome...

ot

Genomes
Apis mellifera
Arabidopsis thaliana
barry
Bombyx mori
Bos taurus
Brachypodium distachyon
Caenorhabditis elegans
Camponotus floridanus
Canis familiaris
Capra hircus
Chinese Hamster
CHO
Drania rerio
Dino Ant
Drosophila melanogaster
E coliK12

A (L Add-ons
#-| | Controls

% Select Genome to Download...

Cancel

Import Genome From Server

Build Custom Gename

M ulcerans

M vanbaalenii

Macaca mulatta
Medicago truncatula
Microtus ochrogaster
Monodelphis domestica
Mus musculus

GRCm33
GRCM39 % Manual Genome Builder
- @ GRCm _
- @ GRCm Species
‘@ GRCm
MCEIM33

[] Create |25

Assembly

pseudo-chromosomes

MCBIM34
MCEIM35

MCBIM36
MCRIMIT

Region name Length

Pseudo Chr Name Pseudo Chr Offset

Features

Read GFF Read Fasta

Add Region

Remove Fegion

Create Genome




File

Edit View Data Plots Filtering
Mew project...

Open project...

Open project and switch assembly...

Import Data

Import Annctation
Export Current View

Save Project

Save Project As...

1 williams.smk

2 2022-11-10.smk

3 all_tet_chip_data_promoters.smk
4 all_tet_chip_data.smk

5 Sample3882.smk

& cho_input_coverage.smk

7 Sample3894.smk

8 DNMT3L_CnR.smk

9 DMNMT3L_CnPR_cgis.smk

Exit

Reports
Crl+M
Ctrl+0

Ctrl+5

File > Import Data

Text (Generic)...
BAM/SAM... Ctrl+I
BED...

BEDPE...

Bizmark (Cov)...
QuasRh...
MethylKit...
Bowtie...

GFF...

SegMonk Project...
Visible Data Stores...
Active Probe List...
HiC Other Ends...

Other format...

i Import Options
Options for BAM File Importer

Remove duplicate reads Mo
Treat as HIC data []
Min HiC interaction distance (bp) 0

Ignore HIC Trans hits

Min mapping quality 20
Primary alignments only
Embedded sample names []

Treat as RMNA-Seq data []

Import Introns Rather than Exons

Data Type Single End

Single End Options

Extend reads by (bp)

Impart Close




Ul Layout and Basic Controls
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Data Types

Annotation Reads
* Annotation collection * Data Set
— All of the annotation in the project — A set of reads which came from one source
(usually file)
* Annotation set
— A collection of features of varying types * Data Group

which came from the same source — A set of reads merged together from

multiple datasets.
e Annotation track

— A set of features of the same type which
might be drawn from several annotation
sets

Replicate Set

— A collection of data sets / groups which
come from the same biological condition



Creating Data Groups / Replicate Sets

Data > Edit Replicate Sets Data > Auto Create Groups/Sets

§ Edit Replicate Sets... % | | G Auto Split Data

Rep Sets Uzed DataStores Lnused DataStores e

(55M307618.bam | Create Replicate Sets
(55M307619.bam

HAad

Select Mamed

REmove Indude Data Groups
Add Mew Replicate Set
Delete Replicate Se
Case Insensitive ]
Rename Se

Close Create Groups Cloze




Changing Chromosome Tracks

* %y VSEE

t2ZE

\

% Select Annotation Tracks
Available Tracks

Cpi3 islands
First EF
IG_segment
miFMA
misc_RMA
pseudogene
rRMA
snoRMA
snRMA

tHRMA

tRMAs

Add

Remowve

Move up

Mowve down

Cancel

Displayed Tracks

aene
mRMA
CD5

(8.4

% Select Data Tracks

Available Tracks

Data Sets

Add

Data Groups

Remaowve

Mowe up

Mowe down

Replicate Sets

Displayed Tracks (2}

(55M307618.bam
(55M307619.bam

Cancel

Ok




Changing Display Preferences

S Edit Display Preferences X
Display which data ':::_'.:_: Reads Only W
Display reads with : Combined Strands o
Raw Read Display Density 'ﬁ:— Low Density w
Replicate Set Display Compressed
Rep Set MA Exdusion Excuded -~
Replicate Set Variahility Mone s
Bars ~
Al

Display Quantitated Data as

Quantitated Data Scale

Quantitation Colour Scheme

Colour Gradient Type

Invert Gradient

-—- Positive Only

.' I L Gradient Colours w

I I I Cold - Hat

[

VIiZE



Movement Controls

Mouse Keyboard
e Scroll Wheel to move left / right e Up arrow to zoom in
 Down arrow to zoom out
* Click and drag to zoom in * Left / Right arrows to move along

* Right click to zoom out
* Control +F to search (find)

* Double click for feature details * Control +G to jump to position (goto)

Mus musculus GRCm38_v100 chr 1:96933333-98503153 (1.5 Mbp)

| I P e b I A Il
| Wd<d<H I = —WE= B H

GENE0T B 5[5 17— o o 2 s s 3 s S B 8 et et B e 2 e s S St R B e o St e o S e e et B e et P . B e s et B e P S 1



Probes and Quantitation
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Terminology for Quantitation

* Probe

— A region of the genome where a measurement will be made. Has a start
and end, and optionally a strand

°* Probe Set

— The full set of probes currently being used for quantitation (eg all the
promoters in the genome)

°* Probe List

— A subset of probes drawn from within the current Probe set (eg all of the
promoters on chromosome 1)



Quantitation Rules

A project can only have a single probe set, and the same probe set
is used to quantitate all data

Each probe has a quantitative value associated with it in every Data
Set and Data Group

Replicate Sets show the mean quantitation of the Data Sets within
them

The chromosome view will show only the currently selected probe
list, and most plots only use data from the current probe list



Probe Generators

(Different ways of
defining a probe set)

Data > Define Probes

% Define Probes...
Probe Generator Options

Running Window Generator
Feature Probe Generator
Feature Percentile Probe Generator
Contig Probe Generator

Ewven Coverage Probe Generator
MACS peak caller

Read Position Probe Generator
Random Position Generator
Current Region Generator

Probe Size (bp)

Step Size (bp)

Limit by region [] Currently Visible Region

Close

Create Annotation Track Create Probes

X
Generator Options
(Options specific to the
currently selected
generator)

Made 13840 probes

Enter Probe Set Name

QK Cancel




Data > Quantitate Existing Probes

* Opens automatically after defining new probes

* Can be rerun on existing probes without changing them

Quantitation Methods

(Different ways of assigning
a value to a probe)

% Define CQuantitation...

Quantitation Options

nrichment Quantitation

Fead Count Quantitation
Base Pair Quantitation

wact Overlap Count Quantitation
Difference Quantitation
% Coverage Quantitation
overage Depth Quantitation
Duplication Quantitation
Distance to Feature Quantitation
Probe Length Quantitation
ined Value Quantitation

Only quantitate visible stores [ ]

Count reads on strand

Correct for total read count

Correct to what?

Count total only within probes

Correct for probe length

Log Transform Count

Count duplicated reads only once

Close Quantitate

All Reads

Largest DataStore

x

S

Quantitation Options
(Options specific to the
currently selected
guantitation method)



Quantitation Example

% Define Probes...

% Define Cuantitation...
Quantitation Options

nrichment Quantitation
Read Count Quantitation

Base Pair Quantitation
wact Overlap Count Quantitation
Difference Quantitation
% Coverage Quantitation
overage Depth Quantitation
Duplication Quantitation
Distance to Feature Quantitation
Probe Length Quantitation
ixed Value Quantitation

Only quantitate visible stores [

Count reads on strand
Correct for total read count
Correct to what?

Count total anly within probes
Correct for probe length

Log Transform Count

Count duplicated reads only once

Close Quantitate

All Reads

iPer Milion Reads

[

O 0O O

>
Probe Generator Options cos ~
|F‘.unning Window Generator
First EF
Feature Percentile Probe Generator gene
Contig Probe Generator BG_segment
Even Coverage Probe Generator Features to design around —
MACS DE?F.( caller misc_RNA
Reag Pnsmn!ﬂ.F‘rnbe Generator mRNA
R.andom Pns!hnn Generator nseudogene
Current Region Generator rRMNA v
Split into subfeatures Mo L
Femove exact duplicates
Ignore feature strand information  []
Make probes Centered on feature  ~ From - | 2000 to +|2000 bp
Close Create Annotation Track Create Probes
Made 13840 probes >

CpG Islands

OK

Enter Probe 5et Mame

Cancel




Probe Lists

Quantitation Example

--[F] €p6 1slands (13840)

G CpG Islands (13840 probes) X W setDataZo.. X
Description: ™ 40
Feature generator using CpG islands duplicates removed Centered on feature from 2000-2000, [
Quantitated with Read Count Quantitation using All Reads correcting for total count per million a0
reads v Bars = Probes | .

Probe Chr Start End oy E I
oe = 0.70 Chri:386... |1 3069388 3673388 | A CheCk the pOSItIOﬂS matCh 0
oe = 0.77 Chr1:448... |1 4430687 4494687| v with what you expect o

Close Save - L 10
‘ ‘ 5
Mus musculus GRCm38_w100 chr1:91344072-91419951 (75.8 kbp)
| | N I [“Cose || Save
| | |
] - } Height = Value = Colour
—— '_-. = - - = = BE R N S — _-.'=-'.'—"'.':.'. - Capped at 95th Percentlle by
default
—— I
[ | | | [
91,370,000 91,350,000 91,590,000 91,400,000 91,410,000



Quantitation Pipelines

e Data > Quantitation Pipelines

e Combine Probe Generation and Quantitation

Pipeline

% Define Cuantitation...

Quantitation Options
F‘JHA—EeqquantEtunpupellne ..........................
Active transcription guantitation pipeline
Intron regression pipeline

Gene trap guantitation pipeline

VWiggle Plot for Initial Data Inspection
Bisulphite methylation over features
Splicing effidency guantitation
Antisense transcription pipeline

Codon Bias Pipeline

Transcription termination pipeline

Only guantitate visible stores ]

Transcript features

Library type

Libraries are paired end

Merge transcript isoforms

Generate Raw Counts

Log transform

Apply transcript length correction
Don't quantitate probes with no counts
Correct for DMA Contamination
Correct for Duplication

Close Run Pipeline

mAMNA e

Mon-strand specific e

& O & O

O O o d

Pipeline Options



Quantitation Adjustment

e Additional Options once you have a quantitation

Blue

Fresh quantitation from the
raw read data

Red

Methods to normalise /
scale / adjust the existing
guantitation

% Define Cuantitation...

Quantitation Options

nrichment Quantitation
Fead Count Quantitation
Base Pair Quantitation
wact Overlap Count Quantitation
Difference Quantitation
% Coverage Quantitation
overage Depth Quantitation
Duplication Quantitation
Distance to Feature Quantitation
Probe Length Quantitation
ined Value Quantitation
Felative Quantitation
Manual Correction Quantitation
og Transform Quantitation
Percentile Mormalisation Quantitation
Eize Factor Normalisation Quantitation
nrichment Mormalisation Quantitation
inear Reagression Mormalisation Quantitation
Subset Mormalisation Quantitation
Per Probe Marmalisation Quantitation
Fank Quantitation
F-5Score Quantitation

Smoothing Quantitation
Emoathing Subtraction Quantitation
Match Distribution Quantitation

Smoothing method Adjacent Probes

Size 5

Only guantitate visible stores ]

Close Quantitate




Plotting Figures
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Plots
Probe Value Histogram...

Read Length Histogram...

Probe Length Histogram... P I Otti n g

Data Store Similarity >
Probe List Overlap >
Dormaincgram...

Hierarchical Clusters >

W

Cumulative Distribution Plot

* By Default
o — Uses the data stores shown in the chromosome view

Box Whisker Plot *
o Wors Pl > — Uses the probes in the selected probe list
Probe Trend Plot... * @ Bean Plot
Ean Flots
Aligned Probes Plot * ; PrDhE Lists My Selected Probe List
Quantitation Trend Plots,,  » =2 Cpi Islands (13‘84”:' GSM307618.bam GSM307619.bam
e My Selected Probe List {13338)
HiC Heatmap * 1204
HiC Cis/Trans Scatterplot
100 A
i i »

HIiC Length Histogram G Select Data Tracks >
Scatter Plot... Available Tracks Displayed Tracks (2) 801

Data Sets 55M307618.bam
e ST Add GSM307619.bam .
Volcano Plot... .

Data Groups rEMOVE
Duplication Plot.., P 40
Wariation Plot... - L

Replicate Sets Move do
Strand Bias Plot... 2
Line Graph... > .
F{NA-Seq 0C Plot... Cancel Highlight Rep Sets Save

Small RNA CQC Plot...



Some Plots are Interactive

% ScatterPlot [My Selected Probe List] X

Flot |GSM307518.bam  » | vs GSM307619.bam  «  [-] Common Scale Highlight Sublists

e Hover to see label

G3M307619.bam My Selected Probe Lis

1204

* Click to fix label

1004

307

* Double click to show
probe in Chromosome
View

601
401w

o - S

* Triple Click to clear labels

=11}
35M307618 . bam

Close Save Probe List Save Image




Some Plots can be Duplicated

% Select Probe Lists to use

Bean Plot > Visible Data Stores...
Probe Lists
Multiple Probe Lists... =I-[5] CpG Islands (13340)
=[] My Selected Probe List (13338)
Multiple Probe Lists and DataStores.., [ chr 1(833)
=] chr 2 (1058)
~[i5] chr X (554)
Chr ¥ (73)
Close Select
% Bean Plots % Bean Plots
X-Ais |
Chr 1 chr 2 G5SM307518.bam GSM307519.bam
GSM307618.bam GSM307619.bam GSM307618.bam G5M307519.bam chr 1 chr 2 Chr X chry chr 1 chr 2 Chr X Chry
100 100
100 100
&0 &0
60 60
40 - 40 1 80 1 &0 1
20 20
o o 60 60
Chr X ChrY
G5M307518.bam GSM307519.bam G5M307518.bam G5M207519.bam
100 100 40 4 40
&0 &0
60 60
20 20
40 1 40 1
20 20 L JL
o o — 0 — 0 — ——
Close Highlight Rep Sets Save Close Highlight Rep Sets Save




Filtering Probes
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Filtering Concepts

Start from an existing Probe List

Run a Filter to select a subset of those probes

Create a new Probe List as a child of the original list

Build up a tree of filtered Probe Lists

Probe Lists

= CpG Islands (13340)

=| My Selected Probe List (13338)

= Chr 1(833)

- li=| Overlapping gene (671)

.[= chr 2 (1058)
- [E] chrx (559
[= chr ¥ (73)




Filters

Filtering
Filter on Values » % Random Probe Filter pd
Filter on Value Differences > | Testing probes in 'CpG Islands' (13840 probes) [——— Starting List
riter on Variance ’ . Check this is what you expect
. . Mumber of lists to generate |1
Filter by Statistical Test >
Filter by Correlation >
Filter by Segmentation Number of probes per list | 100
Filter by Position...
Deduplication Filter... e Run Fter
Filter by Probe Length...
|
Filter by Features.. [Found 100 probes | Number of passed probes

Filter by Feature names...

Enter list name

|
Filter by Probe names... - I : New LiSt Name

Filter Random Probes...

OE Cancel

Duplicate Existing List

Combine existing lists >



_ Probe Lists
=- 5] CpG Islands (13840)
=S| My Selected Probe List (13338)

=[] chr 1(833)

e Overlapping gene (671)
- [5] Chr 2 (1058)
- [i=] Chr ¥ (554)

View List

Make List Report

Convert to annotation track
Sirnilar Lists

Show Probe Length Histogram
Rename

Edit comments

Delete

Filter Details

 Rename list (doesn't change contents)

* View list (shows options used)

e Delete list (and any children)

% Random Probes (100 probes)

Description:

[Random Probe Filter] & random subset of 100 probes from CpG Islands

Comments:

Probe Chr Start End

oe = 0,91 Chr1;309... [1 30947521 30951521
oe = 0,96 Chr1;364... [1 30443092 36447092
oe = (0,78 Chr1;545... [1 54555530 54559530
oe = 0,88 Chr1;70%... [1 70934541 70933541
oe = 0,91 Chr1;977... [1 97768111 97772111
oe = 0,86 Chr1;127... [1 127203285 127207285
oe = 0,87 Chr1;135... [1 135231327 135285827
oe = 1.01Chr1;175... (1 179801432 179305482
oe = 0,75 Chr2:180... |2 18037320 13041920

Close Save




Saving, Reporting and Vistories
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Saving SeqMonk Projects

* File > Save Project

e Saves Everything
— Data
— Quantitations
— Probes / Filters
— Current View

* Single file with .smk file extension
* Can be moved to another machine and opened*

*Unless using a custom genome — you need to copy that separately



Saving Images

% Bean Plots

>

My Selected Probe List

55M307518.bam G5M307519.bam

120 1

100 1

a0

B0 -

40 -

20 7

-

Highlight Rep Sets | Save I

Destination?

Clipboard

bt

: Vistory File

% Save

Save in:

o
=E

Recent Items

Desktop

=

Documents

[

Saved Pictures

2 * @

ile name:

Files of type:

Al Files I
F

FMG Files

PMG Files

St

Save

Cancel

* PNG — Bitmap — Screenshot
* SVG — Vector — Editable




Editing SVG Images

@ “bean_plot.svg - Inkscape = O x

File Edit

My Selected Probe List
GSM307618.bam GSM307619.bam

Object Polygon in root. Click selection again to toggle scale/rotation handles.




Creating Reports

Annotated Probe Report

— Generates a report for every probe in a probe list. Can annotate it with a feature from a
chosen annotation track

Probe Group Report

— Generates a report from a probe list but can group together probes which are close to
each other

Feature Report

— Generates a report for all features in an annotation track. Relates them to probes in a
probe list

Data Store Summary
— Gives statistics about the data and quantitation in the currently selected probe list.



Creating Reports

% Options for Annotated Probe Report for My Selected Probe List x . .
* Sort by clicking head
Reporting on probes in 'My Selected Probe List' (13838 probes) O r C I C I n e a e rS
Annotate with |idosest i« | | gene ~ . .
* Double click to ch
- oupie CIICK TO Change view
Annotation distance cutoff | 2000 bp
[ ] [ ] [ ]
ik ] aroisedpries e Save to file (tab delimited text)
Include w | data for currently visible stores
Select List Annotation 0 annotations selected
Cancel oK
% Annoctated Probe Report for My Selected Probe List >
Probe Chromosome  Start End Probe Strand  Feature 1D Description Feature 5fr... Type Feature Ori... Distance G5M307618.., GSM307a1...

oe =0.70 1 3669333 3673338 (+ wkr4 EMSMUSE00. ., [Xdinked Kx bl... |- gene overlapping i 22.471 11,923 &

oe =077 1 4490687 44949587 [+ Sox17 EMSMUSGE00. ., [SRY (sex det... |- gene overlapping 0 33.279 22,162

oe = 1.00 1 4495278 4499273 (4 Sox17 EMSMUSGE00. ., [SRY (sex det... |- gene overlapping 0 9.845 27.346

oe =0.61 1 4558325 4562325(4+ Mot found 0 0.214 0]

oe =0.78 1 4565230 4569280 (4 Mot found 0 0.428 0,518

oe =077 1 4569358 4573858+ Mot found 0 12,9498 68.61

oe = 0.30 1 4783595 4787595+ Mrpl15 EMSMISGE00. .. [mitochondrial. .. |- gene overlapping ] 49,223 0,778

oe =0,92 1 4305831 4309831+ Lyplal EMSMUISGE00. .. (lysophosphali... |+ gene overlapping ] 27.073 0.648

oe = 0,81 1 4355919 4359919(4+ Gm37988 EMSMUISGE00. ., |predicted ge... |+ gene overlapping 0 33.921 1,296

oe =0.78 1 5017134 5021134(+ Rgs20 EMSMUISGE00. ., [regulator of ... |- gene overlapping 0 27.073 25.142

oe = 0,82 1 5081258 5085288 (+ Atpavih EMSMUSGO00. .. |ATPase, H+ ... |+ gene overlapping 0 15.944 0,518
=Y [ - 1 EZASTILS EZFETIAS 0 Pl Fmamd N N oS [ - = e

Save to File Save to Vistory




Vistories

A way to formally record your activities in SegqMonk
Generates an HTML report

Created automatically

You can add commentary, images, reports and summaries
Easy way to record and share your analysis



Vistories

G vistory — O

* Load I Save I Save As I Title I Subtitle ttText |£|Paste Image ®Clear

x

Summary @ Sawe HTML

G Vistory - O

f Load I Save I Save As I Title I Subtitle ttText |£| Paste Image ®Clear

*

Summary @I Save HTML

DataSet Added

G5M307618.bam E: \llumina Analysis\SegMonk_Course_DataGSM307618.bam Library type Single End Dedup=No MAPQ >=20 Primary alignments <
only.

DataSet Added

(35M307619.bam E: \llluminag Analysis\SeqMank_Course_Data\G3M307619.bam Library type Single End Dedup=No MAPQ ==20 Primary alignments <
only.

Mew Probe Set:CpG Islands (13840 probes)

Feature generator using Cp islands duplicates removed Centered on feature from 2000-2000 ¢

Probes Quantitated
Read Count Quantitation using All Reads correcting for total count per milion reads

Mew Probe List: My Selected Probe List {13838 probes)
[Probe Values Filter] Filter on probes in CpG Islands where exactly 2 of GSM307618.bam , GSM307613.bam had a value below 200.0. Quantitation was <
Read Count Quantitation using All Reads correcting for total count per million reads

Mew Probe List: Chr 1 (833 probes)
[Position Filter] Probes from My Selected Probe List which are on chromosome 1 on strand All Probes B

Mew Probe List: Chr 2 {1058 probes)

[Pasition Filter] Probes from My Selected Probe List which are on chromosome 2 on strand All Probes <
Mew Probe List: Chr X (554 probes)

[Position Filter] Probes from My Selected Probe List which are on chromosome X on strand All Probes ¢
Mew Probe List: Chr Y (73 probes)

[Position Filter] Probes from My Selected Probe List which are on chromosome Y on strand All Probes <

Mew Probe List: Overlapping gene (571 probes)

[Feature Filter] Filter probes in Chr 1 on regions based an gene Qver feature relationship is Overlapping <

Mew Probe List: Random Probes (100 probes)

[Random Probe Filter] A random subset of 100 probes from Cp Islands <

L.

Example Vistory

This is an example which shows what you can do with vistories.

Load the data

DataSet Added
GSM307618.bam E:\lllumina Analysis\SeqMonk_Course_Data\GSM307613.bam Library type Single End Dedup=Mo MAPQ ==20 Primary alignments
only.

DataSet Added
G5M307619.bam E: llumina Analysis\SeqMonk_Course_Data\35M307619.bam Library type Single End Dedup=No MAPQ==20 Primary alignments
only.

Make Probes

New Probe Set:CpG Islands (13840 probes)
Feature generator using CpG islands duplicates removed Centered on feature from 2000-2000

Quantitate

Probes Quantitated
Read Count Quantitation using All Reads correcting for total count per milion reads

Filter

New Probe List: My Selected Probe List (13838 probes)
[Probe Values Filter] Filter on probes in CpG Islands where exactly 2 of GSM307618.bam , GSM307519.bam had a value below 200.0. Quantitation was
Read Count Quantitation using All Reads correcting for total count per milion reads

Mew Probe List: Chr 1 (833 probes)
[Position Filter] Probes from My Selected Probe List which are on chromosome 1 on strand All Probes

MNew Probe List: Chr 2 (1058 probes)
[Position Filter] Probes from My Selected Probe List which are on chromosome 2 on strand All Frobes

New Probe List: Chr X (554 probes)
[Position Filter] Probes from My Selected Probe List which are on chromosome X on strand All Probes

MNew Probe List: Chr Y (73 probes)

L




Vistories

G vistory — O >

Summary @ Save HTML

Load I Save I Save As T Tite T Subtitle ttText Ii_l Paste Image ®Clear
Plotting IR

We can demonstrate how to embed plats into the vistory E
My Selected Probe List @ SeqMonk Vistory Report * + g - [m} =
GSM307518.bam G5SM307519.bam
C @ O files/f/C:/Usersfandrewss/Pictures/Saved Pictures/example_vistor 1.7 Y I8 0 @ 5 =

120 1
100 1 %
a0 | Example Vistory

Load the data .
—— SeqMonk Vistory

Quantitate
40 1

Filter
20 1 Plotting .

- Example Vistory
.
- This is an example which shows what you can do with vistories.
Reporting
Load the data
| DataStore TotalR... Forwar... Revers... Unknow... MeanR... TotalR... FoldCo... TotalQ... Median... Mean Q... WValid
GSM3076... (3345214  [4674124  |4671090 [0 33 317580516 [0.11652.., |318641.2...20.973303 [23.026543 |1333¢ o e
IGSMSO?G... 7716069 (3858872 |3857187 [0 28 216436208 (0.07941... |30893.19...|1.9439951 (5.84609 13834
GSM307615.bam E i i nk_Course D 9 bam Library type Single End Dedup=Na MAPQ==20 Primary alignments anly.

Make Probes
e Save as .smv file (editable) T

Quantitate

* Save as HTML (report)

Read Count Quantitation using All Reads correcting for total count per million reads.




™9 ‘ & VistoryDE - A database of Seql. X +

< C @

Vistory DB

A collection of SeqMonk Vistory files

About

Filters

| Type search term here |

ngs(4) chip-seq(1) peak calling(1)
annotation(1) promoter(1l) rna-seq(2)
statistics(3) qc(2) wvisualisation(2)

reporting(1)
Vistories

Calling Peaks from Replicated ChIP
Data

In replicated ChlP-Seq datasets there are a
few different ways to call peaks. We go
through a few options for how to call peaks,
explaining the differences between them and
the strengths and weaknesses of each

ngs,chip-seq,peak calling

Annotating probes with promoters

O E] https:/fwwnw. bioinformatics.babraham.ac.uk/vistorydb/

https://www.bioinformatics.babraham.ac.uk/vistorydb/

o
L]
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Calling Peaks on
ChIP data with
Replicates

SegMonk Vistory

Project Summary

Basic Project Info
Data Sets

Quantitation

Calling Peaks on ChIP data with Replicates

Strategies for
multiple peak
calling

(6= ) o <4 At the end we want to have a single set of probes which are the peaks we would take forward for further
analysis.

In this vistory I'm going to look at calling peaks on some replicated ChIP data. We have two replicates and a
single input and we're going to look at a couple of options for how to build a peak list from them.

Calling Peaks

Mersed Data At the start we've just imported the data and have done a simple running window quantitation. We can see
1

that we have strongly enriched peaks in both of the replicates and that in general the peak positions look

Individual Peak Calls similar.

Combining Peaks




